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El estudio de las características de los eritrocitos se realiza mediante distintas pruebas, entre ellas la microscopía 

y el análisis de imágenes. El propósito de este artículo es desarrollar un algoritmo funcional en el software ImageJ 

para identificar las características morfológicas de los eritrocitos y determinar la variación de la fragilidad osmótica 

cuando estos son expuestos a distintas condiciones. Las imágenes utilizadas fueron observadas mediante un mi-

croscopio Leica Aristoplan y capturadas por una cámara Leica DMC6200 conectada al equipo, para posteriormente 

ser procesadas en el software ImageJ. El algoritmo describe de forma ordenada el proceso que se realiza desde la 

calibración de la imagen hasta la obtención de resultados cuantitativos. Este proceso incluye la calibración según 

el aumento del microscopio, la corrección de posibles errores en la imagen y la identificación de las células para 

la obtención de parámetros como el área, el perímetro, la redondez y el diámetro de Feret. La aplicación del algo-

ritmo en ImageJ permite un procesamiento de imágenes que facilita la cuantificación morfológica de eritrocitos. 

El algoritmo presentado es eficiente y reproducible, además puede ser adaptado según las necesidades del usuario. 

Tras el análisis, se concluye que el algoritmo puede ser modificado según los requerimientos del usuario. En con-

junto, el algoritmo facilita el uso de ImageJ para la cuantificación morfológica de eritrocitos. 
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Abstract 
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In  

The study of erythrocyte characteristics is carried out through different tests, including microscopy and image 

analysis. The purpose of this article is to develop a functional algorithm in the ImageJ software to identify the 

morphological characteristics of erythrocytes and to determine the variation in osmotic fragility when they are 

exposed to different conditions. The images were obtained using a Leica Aristoplan microscope and captured with 

a Leica DMC6200 camera connected to the equipment, and subsequently processed in ImageJ. The algorithm 

provides an orderly description of the process, from image calibration to the acquisition of quantitative results. 

This process includes calibration according to the microscope magnification, correction of possible image errors, 

and identification of cells to obtain parameters such as area, perimeter, roundness, and Feret’s diameter. The ap-

plication of the algorithm in ImageJ enables image processing that facilitates the morphological quantification of 

erythrocytes. The algorithm presented is efficient and reproducible, and can also be adapted according to user 

needs. Based on the analysis, it is concluded that the algorithm can be modified depending on specific require-

ments. Overall, the algorithm facilitates the use of ImageJ for the morphological quantification of erythrocytes. 
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Introducción 

 

La microscopía fue un factor determinante y rele-

vante para el desarrollo de la investigación en orga-

nismos vivos a lo largo de la historia. Tiene su inicio 

con Robert Hooke en 1665, cuando inventó aparatos 

con lentes de vidrio para poder realizar la observa-

ción, medición y registro de diversos fenómenos, 

permitiéndole ser el primero en describir la célula y 

realizar la observación de la estructura de tejidos fi-

nos1,2. El microscopio se ha convertido en una herra-

mienta universal utilizada en distintas áreas de inves-

tigación, por esto da infinitas posibilidades de estu-

diar la morfología, composición, estructura y otras 

características de diversos organismos vivos y mate-

ria inorgánica. 

Las características de la célula fueron estudiadas du-

rante mucho tiempo; las primeras investigaciones 

microscópicas de la sangre comenzaron con Marce-

llo Malpighi, quien describió estructuras capilares y 

tejidos, cuestionando las creencias sobre la composi-

ción sanguínea de su época. Posteriormente, Antonie 

van Leeuwenhoek y Jan Swammerdam observaron al 

microscopio las células sanguíneas, a las que deno-

minaron “globuli rubri” (glóbulos rojos)3. 

Con el desarrollo de nuevas tecnologías, los estudios 

sobre los glóbulos rojos se han perfeccionado, permi-

tiendo caracterizar su forma, tamaño, densidad, diá-

metro y color. Estas propiedades son utilizadas en la 

actualidad para el diagnóstico de diversas enferme-

dades hematológicas, como las anemias, entre ellas 

la anemia megaloblástica4. 

Los eritrocitos son células sanguíneas presentes en 

todo el organismo, responsables del transporte de 

oxígeno hacia los tejidos y de la eliminación del dió-

xido de carbono generado en la respiración celular5. 

Un eritrocito saludable tiene forma de disco bicón-

cavo con un centro deprimido, carece de núcleo y 

presenta un color rojo característico debido a su alta 

concentración de hemoglobina, una proteína rica en  

 

 

hierro. El diámetro promedio de un eritrocito en una 

persona adulta oscila entre 7 y 8 µm6. 

La forma, dimensiones y características de los eritro-

citos observadas al microscopio pueden alterarse en 

presencia de enfermedades o cambios en sus condi-

ciones fisiológicas. Un ejemplo claro es la anemia 

falciforme, que provoca la deformación de los eritro-

citos en forma de hoz, dificultando su paso por los 

vasos sanguíneos pequeños y favoreciendo la hemó-

lisis7. 

Entre estas enfermedades, muchas alteraciones pue-

den detectarse mediante el análisis morfológico de 

los eritrocitos, y diferentes técnicas han permitido 

identificar diversos tipos de anemia según la forma 

celular. Por otro lado, condiciones como la policite-

mia (eritrocitosis) pueden reconocerse por el conteo 

elevado de eritrocitos. Asimismo, la clasificación pa-

tológica de estas células puede realizarse mediante 

observación microscópica6,8,9. 

Para mejorar la visualización de las células sanguí-

neas al microscopio se han desarrollado diversas téc-

nicas de tinción que permiten resaltar sus caracterís-

ticas morfológicas. Entre las más utilizadas en hema-

tología se encuentran las tinciones de Wright, Giem-

sa y Leishman, cada una con aplicaciones específi-

cas. La tinción de Wright, por ejemplo, se emplea en 

frotis sanguíneos para diferenciar los componentes 

celulares, tiñendo los núcleos de azul y el citoplasma 

de tonos rosados10,11. 

Las tinciones facilitan la visualización de las estruc-

turas celulares al microscopio; sin embargo, para lo-

grar una cuantificación más precisa de estas caracte-

rísticas se recurre a la captura de imágenes mediante 

cámaras acopladas al microscopio y a su posterior 

análisis con software especializado. 

El análisis de las diferencias en las imágenes obteni-

das es fundamental para identificar variaciones y 

cambios en sistemas vivos o en estructuras difíciles 
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de percibir a simple vista. Gracias al desarrollo tec-

nológico, en la actualidad es posible realizar recons-

trucciones tridimensionales de estructuras mediante 

técnicas como la criomicroscopía electrónica de alta 

resolución12. Estos avances han impulsado la ciencia 

y permitido una comprensión más profunda de los 

comportamientos y características de los sistemas vi-

vos. 

En un principio, los programas informáticos se utili-

zaban principalmente para el almacenamiento de 

imágenes. Posteriormente surgieron los primeros 

programas de edición, como Adobe Photoshop13, que 

fue uno de los primeros en aplicarse a la microscopía 

para la edición de imágenes. Más adelante se desa-

rrollaron programas más especializados, como Ima-

geJ en 1997, derivado del NIH Image14. En la actua-

lidad, la microscopía permite capturar y almacenar 

imágenes o videos de los fenómenos observados, es-

tos pueden analizarse mediante software especiali-

zado. Entre estos destacan FIJI, ImageJ15, Icy16. y Or-

bit17, que facilitan la identificación y procesamiento 

de estructuras, permitiendo caracterizarlas de manera 

más clara18. 

ImageJ es uno de los programas más destacados en 

el análisis y procesamiento de imágenes, amplia-

mente utilizado en el ámbito científico19. Permite un 

análisis riguroso de datos visuales y resulta especial-

mente útil en el estudio de sistemas biológicos gra-

cias a su gran variedad de herramientas20. Al ser de 

código abierto y gratuito, puede utilizarse desde cual-

quier computadora, lo que facilita su acceso univer-

sal. Además, cuenta con instrucciones y funciones 

que hacen de su uso una experiencia sencilla y prác-

tica21. 

Para aprovechar al máximo programas libres como 

ImageJ, que facilitan el manejo de la información y 

el análisis de datos, es necesario estandarizar algorit-

mos para el estudio de imágenes biológicas, con el 

fin de simplificar la investigación y el análisis de re-

sultados. Actualmente no existen protocolos estanda-

rizados que describan de manera sistemática el uso 

de este programa en el análisis de eritrocitos, a pesar 

de que la observación microscópica es un método co-

múnmente utilizado para la detección de enferme-da-

des. Sin embargo, se han desarrollado investigacio-

nes que realizan el conteo celular en plataformas 

como MATLAB22 y otras que proponen métodos es-

pecíficos, como el planteado por Chadha et al.23. 

El objetivo de este artículo es proponer un algoritmo 

para el análisis de imágenes de eritrocitos, que per-

mita obtener parámetros morfológicos cuantitativos 

como diámetro, área, redondez y conteo celular me-

diante el uso del software ImageJ. 

 

Materiales y métodos 

 

Preparación del paciente. Previo a la toma de mues-

tras, se realizó un hemograma completo en el labora-

torio del Hospital General de La Paz para descartar 

alteraciones hematológicas que pudieran afectar los 

resultados. El individuo presentó un hematocrito de 

49 %, dentro de los valores normales para su edad y 

género24. Una vez confirmado el estado saludable, se 

firmó un consentimiento informado para su partici-

pación en el estudio, según lo establecido por el Co-

mité de Bioética de la Universidad Católica Boli-

viana “San Pablo”, sede La Paz. La investigación se 

llevó a cabo entre noviembre de 2023 y marzo de 

2024. 

Toma de muestra. Se obtuvieron muestras de un 

mismo individuo para evitar la variabilidad de los da-

tos. Durante 5 días consecutivos se extrajo diaria-

mente una muestra de 3 mL de sangre, a una tempe-

ratura ambiente de 25° C, colocada en tubos con 

EDTA como anticoagulante (Vacuette, lote 454217). 

Preparación de la muestra previa a la observación. 

La sangre fue procesada según el método de Alonso-

Geli et al.25; se centrifugó a 1000 g durante 10 min 

para separar el plasma. Posteriormente se tomaron 40 

µL del paquete globular restante, que se lavaron en 4 
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mL de solución de cloruro de sodio (NaCl) (Scharlab 

S.L., España, lote 11285202). Este procedimiento se 

repitió con 12 concentraciones distintas de NaCl, 0.0, 

0.1, 0.2, 0.25, 0.3, 0.32, 0.36, 0.4, 0.45, 0.55, 0.7 y 

0.9 %. Finalmente, las muestras se centrifugaron nue-

vamente durante 10 min en una centrifugadora 

(Sigma, Alemania). 

Con el paquete globular preparado, se depositó una 

gota en el portaobjetos, se realizó el frotis exten-

diendo la muestra y se dejó secar a temperatura am-

biente (25° C) durante 30 min26. 

Para mejorar la visualización y distinción de los eri-

trocitos en cada muestra se utilizó el kit de tinción 

Wright’s Dip Stat (Chemical Corporation, Estados 

Unidos, lote A187), que contiene cuatro soluciones 

de 250 mL: solución fijadora, tinción eosinada, tin-

ción policromática y solución de enjuague. La mues-

tra se tiñó según la técnica descrita por Li et al.27. Una 

vez finalizado el procedimiento, se dejó secar durante 

1 h. Finalmente, se añadió una gota de dipex para pre-

servar la preparación a temperatura ambiente y se co-

locó el cubreobjetos encima. 

Observación de la muestra en el microscopio. Las 

muestras fueron observadas en un microscopio Leica 

Aristoplan (Alemania) con lentes de 40x, 50x y 100x. 

Las imágenes se capturaron mediante una cámara 

Leica DMC6200 Pixel Shift (Alemania), conectada 

al microscopio. Se registraron imágenes con cada 

lente, seleccionando el campo que permitiera dife-

renciar con mayor claridad las características celula-

res. Una vez finalizada la observación, las imágenes 

fueron seleccionadas y codificadas para su posterior 

análisis. 

Análisis de muestras en ImageJ. Se utilizó el pro-

grama ImageJ, descargado desde la red. Una vez ins-

talado, se ingresó a la aplicación en la computadora. 

Para explorar sus herramientas, se empleó la pestaña 

File → Open Samples, que muestra un menú de imá-

genes preseleccionadas por el programa. Para iniciar 

el análisis de las muestras, se seleccionó File → 

Open y se cargó la imagen correspondiente. Las imá-

genes analizadas se encontraban en formato TIFF, 

que ofrece mejor calidad para el manejo de detalles; 

sin embargo, ImageJ acepta múltiples formatos como 

PNG, GIF y JPEG28. 

Una vez seleccionada la imagen, se visualizó en la 

pantalla. En la parte superior de la ventana, debajo de 

la barra de herramientas, se mostraban el nombre, 

formato, resolución, sistema de color y tamaño del 

archivo (Figura 1). Al mover el cursor por la pantalla 

y seleccionar un punto, aparecían las coordenadas x 

e y del área seleccionada; mediante clic derecho o iz-

quierdo se podía aumentar o reducir el tamaño de la 

ventana de la imagen. 

 

 

 
Figura 1 Captura de pantalla del software ImageJ que muestra la 

barra de herramientas disponibles 

 

Calibración de la imagen. Para iniciar el trabajo con 

la aplicación es necesario calibrar la imagen de 

acuerdo con las medidas del microscopio. Para ello, 

durante la observación se debe capturar una imagen 

de un objeto con dimensiones conocidas, que se uti-

lizará como imagen de referencia. Es indispensable 

contar con una imagen de referencia para cada lente 

empleado. 
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El procedimiento consiste en abrir la imagen de refe-

rencia correspondiente al lente, seleccionar la herra-

mienta de línea y trazar una recta sobre el objeto cuya 

medida se conoce. Luego, en el menú Analyze se 

elige la opción Set Scale; en el campo Known Dis-

tance se introduce la medida conocida y en Unit of 

Length se selecciona la unidad correspondiente, ajus-

tando así la escala al tamaño real de la imagen a ana-

lizar. Una vez realizada la calibración, las unidades 

se mostrarán de acuerdo con las establecidas por el 

usuario. En las imágenes tomadas con el mismo lente 

se mantiene la calibración inicial; sin embargo, al 

cambiar de lente se debe repetir el proceso de cali-

bración (Figura 2). 

 

 

 
Figura 2 Algoritmo del proceso de calibración de la imagen en el soft-

ware de ImageJ 

Procesamiento de la imagen. Una vez realizada la ca-

libración, se abre la imagen a analizar. En el menú se 

selecciona Image → Adjust → Color Threshold; si 

no se desea realizar configuraciones adicionales, se 

cierra la ventana emergente, lo que genera un fondo 

rojo en la imagen. Posteriormente, en el menú se se-

lecciona Process → Binary → Make Binary (Figura 

3), convirtiendo la imagen a blanco y negro. El fondo 

debe aparecer negro y las células en blanco; si esto 

no ocurre, se debe ir a Edit → Invert, lo que invierte 

los colores y establece el fondo en negro y las células 

en blanco. 

 

 

 
Figura 3 Captura de pantalla del software ImageJ de un paso del 

algoritmo de procesamiento de la imagen 

 

Si las células no pueden distinguirse entre sí, debido 

a que se encuentran muy próximas, se puede utilizar 

la herramienta Erode, que reduce un píxel del con-

torno de las áreas blancas correspondientes a los eri-

trocitos. Finalmente, se selecciona Process → Binary 

→ Fill Holes para garantizar que el cálculo del área 

se realice de manera completa (Figura 4). 
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Figura 4 Algoritmo del procesamiento de la imagen en el software de 

ImageJ 

 

Visualización de resultados. Primero, se selecciona 

la opción Analyze → Set Measurements y se debe 

asegurar que las opciones requeridas estén activadas. 

En este caso se utilizaron: Area, que determina el 

área de la célula; Perimeter, que calcula el perímetro 

de cada célula; Shape Descriptors, parámetro que in-

dica, en un rango de 0 a 1, la similitud con una forma 

circular; Feret’s Diameter, que mide el diámetro en 

una dirección específica; y Add to Overlay, que 

asigna un número a cada célula en la imagen según 

el conteo realizado. Finalmente, es necesario verifi-

car que en la opción Redirect to para que aparezca el 

nombre de la imagen en la que se está trabajando, 

para asegurar que el procesamiento se realice correc-

tamente (Figura 5). 

 

 

 
Figura 5 Algoritmo para realizar la visualización de resultados en el 

software de ImageJ 

 

Análisis de partículas. El siguiente paso consiste en 

seleccionar Analyze → Analyze Particles. Con esta 

opción es posible modificar los parámetros de 

acuerdo con las necesidades del análisis; en este caso 

se mantuvieron las configuraciones preestablecidas 

por la aplicación: en Size de 0 a ∞, en Circularity de 

0 a 1, y en Show se seleccionó Overlay Masks. Ade-

más, se verificó que estuvieran activadas las opciones 

Display Results (para mostrar los resultados), Clear 

Results (para evitar repeticiones) y Exclude on Edges 

(para excluir las células incompletas en los bordes de 

la imagen). 
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Tras completar este procedimiento, la imagen se 

mostró con fondo negro y cada célula apareció mar-

cada con un color y un número (Figura 6). Simultá-

neamente se generó una tabla con todos los resulta-

dos. Los datos que resulten incongruentes pueden 

ajustarse delimitando los parámetros en Set Measu-

rements. 

 

 

 
Figura 6 Resultados de las configuraciones empleadas en las imáge-

nes para contabilizar las células presentes 

 

Resumen y almacenamiento de resultados. Para fina-

lizar, se puede obtener un resumen de los datos en la 

misma tabla mostrada. Se selecciona Results → Sum-

marize, y en la parte inferior aparecerán los datos de 

forma resumida. En la Tabla 1 se presentan de ma-

nera similar a como los muestra el software. Por úl-

timo, si se desea guardar estos resultados, se selec-

ciona Results → File → Save, lo que permite alma-

cenarlos en formato Excel o en formato TXT. 

 

Resultados 

 

El algoritmo final desarrollado para su implementa-

ción en el software ImageJ es el resultado del proceso 

descrito en las etapas anteriores (Figura 7). Este al- 

goritmo facilita el análisis de las imágenes y permite 

obtener parámetros morfológicos cuantitativos de los 

eritrocitos observados, como el área, perímetro, re-

dondez y diámetro de Feret. Además, busca optimi-

zar el procesamiento de imágenes de microscopía, 

garantizando que los resultados sean reproducibles, 

precisos y fáciles de interpretar. 

Este algoritmo busca facilitar el análisis morfológico 

de los eritrocitos y ofrecer una herramienta adaptable 

a diferentes tipos de muestras biológicas con morfo-

logía similar. De esta manera, se simplifica el uso de 

ImageJ para investigadores que requieran un proce-

dimiento estandarizado y funcional en el análisis ce-

lular. 

Todos los valores fueron calculados automática-

mente por el programa tras la aplicación del algo-

ritmo. Como se observa, las desviaciones estándar de 

los parámetros de área, perímetro, circunferencia y 

diámetro de Feret son bajas, lo que evidencia una 

adecuada consistencia del procedimiento y una co-

rrecta delimitación de la imagen (Tabla 1). A partir 

de este algoritmo se realizó un análisis más especí-

fico de las variaciones morfológicas de las muestras 

bajo distintas condiciones osmóticas, aplicando el 

método propuesto y siguiendo la metodología des-

crita en el documento. 

El análisis realizado muestra una tendencia ascen-

dente en el área promedio de los eritrocitos a medida 

que disminuye la concentración de NaCl en el medio 

(Tabla 2). Paralelamente, se observa una disminu-

ción en el diámetro de Feret. Los valores de desvia-

ción estándar se mantienen bajos en relación con los 

promedios, lo que confirma la precisión del algo-

ritmo. Estos cambios señalan que el método es capaz 

de detectar diferencias morfológicas. En conjunto, 

los resultados evidencian que el algoritmo diseñado 

en ImageJ permite cuantificar parámetros morfológi-

cos de manera reproducible, facilitando la obtención 

de datos verificables bajo distintas condiciones de 

observación. 
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Tabla 1 Resultados de la muestra de sangre a 100x analizada en ImageJ 

 
 Label Area Perim. Circ. Feret FeretX FeretY FeretAngle MinFeret AR Round Solidity 

77 Mean 0.013 0.509 0.674 0.147 861.882 581.474 100.048 0.121 1.212 0.843 0.942 

78 SD 0.003 0.133 0.149 0.025 521.309 312.855 51.697 0.013 0.212 0.108 0.033 

79 Min 0.01 0.396 0.168 0.122 20 19 8.315 0.088 1.006 0.443 0.834 

80 Max 0.028 1.006 0.869 0.249 1792 1152 178.85 0.166 2.256 0.994 0.977 

 

Tabla 2 Resultados de valores promedio de área y diámetro de eritrocitos a distintas concentraciones de NaCl (100x) 

 

Concentración NaCl (%) 
Aumento 100x 

Parámetro Area [µ2] Feret [µm] 

0.9 

mean 15.52315 5.05292 

SD 049921 0.09452 

Min 15.17016 4.98608 

Max 15.87615 5.11975 

0.4 

mean 25.96679 6.41365 

SD 6.15619 1.33875 

Min 18.07716 4.97799 

Max 40.60766 9.86242 

0.32 

mean 19.06149 6.06803 

SD 3.70165 0.5807 

Min 12.6247 5.14902 

Max 24.4628 7.09696 

 

 

 
Figura 7 Algoritmo final para realizar la caracterización de los eri-

trocitos 

Discusión 

 

Muchas de las herramientas utilizadas para la obser-

vación en ImageJ también se encuentran disponibles 

en otros programas. En el estudio de Mejía & Al-

zate29, el análisis de los eritrocitos según su forma se 

realizó en la plataforma MATLAB, donde se llevó a 

cabo el procesamiento de imágenes y la caracteriza-

ción morfológica en función de su forma y tamaño. 

Estos autores señalan que es posible emplear MAT-

LAB para medir parámetros morfológicos en micros-

copía. La preferencia por ImageJ frente a MATLAB 

radica en su accesibilidad y facilidad de uso30. A di-

ferencia de MATLAB, que requiere licencia de pago 

y conocimientos avanzados de programación al no 

estar especializado en análisis de imágenes, ImageJ 

es gratuito, de fácil instalación y cuenta con una am-

plia comunidad de usuarios, además de múltiples he-

rramientas orientadas al análisis de imágenes bioló-

gicas. 
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En concordancia con estas ventajas, diversos autores 

han destacado la relevancia de las herramientas 

computacionales abiertas. Li et al.31. realizaron una 

revisión sobre el uso de plataformas libres en el aná-

lisis de imágenes biomédicas, subrayando su papel en 

la estandarización y accesibilidad de los métodos 

científicos. Además, señalaron que la mayoría de los 

estudios carecen de parámetros que permitan replicar 

sus procedimientos. Estos hallazgos respaldan el uso 

de ImageJ como plataforma eficaz y accesible, pro-

moviendo la creación de algoritmos reproducibles 

para la caracterización morfológica de células san-

guíneas, especialmente en entornos académicos y de 

investigación donde la reproducibilidad y el bajo 

costo son esenciales. 

El algoritmo desarrollado en ImageJ podría comple-

mentarse en el futuro con estrategias de deep lear-

ning para crear sistemas de diagnóstico automatizado 

que combinen la precisión del procesamiento digital 

con la interpretación inteligente de imágenes biomé-

dicas. Cakmak & Pacal32 evidenciaron que la inteli-

gencia artificial puede emplearse en el diagnóstico de 

anemia mediante técnicas de machine learning, apro-

vechando la capacidad de estas herramientas para de-

tectar patrones morfológicos y clasificar células san-

guíneas de manera automática, contribuyendo así a la 

detección temprana de enfermedades hematológicas. 

Además, los avances recientes en inteligencia artifi-

cial han destacado el potencial de integrar algoritmos 

de análisis de imágenes con modelos de aprendizaje 

profundo. Un ejemplo es la herramienta denominada 

RedTell, diseñada para interpretar la morfología de 

eritrocitos33. De igual forma, estudios como los de 

Foy et al.34 y Ghosh et al.35 han señalado la utilidad 

de la inteligencia artificial para facilitar el análisis y 

la obtención de datos sobre las características morfo-

lógicas de los eritrocitos. El algoritmo utilizado en 

esta investigación es específico para medir paráme-

tros morfológicos de los eritrocitos. No obstante, su 

estructura puede adaptarse al análisis de células con 

morfología circular o cuasiesférica. En futuros traba-

jos sería conveniente evaluar su rendimiento en célu-

las con formas distintas o morfología irregular. 

Para finalizar, es importante considerar ciertas reco-

mendaciones que previenen errores potenciales capa-

ces de afectar el rendimiento del algoritmo. Entre 

ellos, la preparación correcta de la muestra, como la 

delicada realización del frotis26; si este no permite 

observar zonas donde las células estén dispersas, la 

imagen no podrá utilizarse, incluso con la herra-

mienta de corrección Erode. Lo mismo sucede 

cuando la tinción no se realiza de manera apro-

piada27. Otro error frecuente se relaciona con la iden-

tificación y delimitación del tamaño celular; en la 

imagen pueden aparecer estructuras distintas al ob-

jeto de estudio, como leucocitos, que por su tamaño 

destacan tras la tinción (Figura 1). Este problema 

puede descartarse al seleccionar el parámetro Area, 

delimitando el conteo de componentes. También, la 

toma de la imagen para la calibración debe ser pre-

cisa, ya que resulta determinante en todo el proceso36. 

Además, la calibración correcta de la microscopía 

con la retícula micrométrica es esencial para asegurar 

la fiabilidad de las mediciones. Cada lente objetivo 

debe calibrarse de manera independiente, dado que 

las variaciones en el aumento modifican la escala de 

conversión de píxeles a micrómetros. En conjunto, 

los resultados y consideraciones presentadas refuer-

zan la validez del algoritmo como herramienta con-

fiable para el análisis de imágenes orientado al estu-
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dio morfológico de eritrocitos. La principal contribu-

ción de este trabajo radica en la estandarización de 

un algoritmo reproducible y accesible para cualquier 

científico que se inicie en el análisis de imágenes me-

diante un software libre como ImageJ, permitiendo 

la obtención de datos precisos sin recurrir a progra-

mas de alto costo. La implementación de este algo-

ritmo en ImageJ facilita el estudio de imágenes he-

matológicas y puede adaptarse al análisis de células 

con morfología similar, constituyendo una base só-

lida para futuras investigaciones. De este modo, el al-

goritmo propuesto contribuye a la estandarización 

del análisis morfológico de eritrocitos en la investi-

gación. 
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